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Д
ля создания высокоэффективного и ус-

тойчивого приложения в процессе ин-

теграции необходимо предпринять ряд

мер. В этой статье даются рекомендации по

интеграции LwIP с другими периферийны-

ми узлами или программными компонента-

ми системы, следование которым позволит

избежать большинства типичных ошибок

при разработке приложений на базе LwIP на

процессорах Blackfin. Также для облегчения

построения эффективной системы в статье

обсуждаются используемые при реализации

стека LwIP ресурсы процессора.

Мотивация

В последнее время встраиваемые сетевые

приложения все чаще становятся ориентиро-

ванными на передачу мультимедийного со-

держимого по проводным или беспроводным

сетям. Поддержку сетевого взаимодействия

также желательно иметь в приложениях, от-

носящихся к таким областям, как промыш-

ленная автоматизация и управление. На рис. 1

показаны типовые приложения, в которых

желательна возможность подключения к ин-

тернету.

Компанией Analog Devices разработаны

бесплатные (распространяемые на условиях

лицензионных соглашений) программные

составные блоки, помогающие ускорить со-

здание сложных встраиваемых сетевых при-

ложений. Далее приводится список базовых

программных компонентов, поставляемых

в составе среды разработки программного

обеспечения процессоров Analog Devices

VisualDSP++ версий 4.5 и выше:
•• LwIP — облегченный стек TCP/IP [1], пор-

тированный на процессоры ADSP BF53x

и ADSP BF56x1.

•• Драйверы устройств и библиотеки систем-

ных служб (SSL, system services libraries) —

API-функции для конфигурирования сис-

темных ресурсов и периферийных уст-

ройств и управления ими [10].
•• VisualDSP++ Kernel (VDK) [13] — ядро ре-

ального времени. Это нетребовательное

к ресурсам ядро может использоваться для

эффективного управления системными ре-

сурсами в среде многозадачного приложе-

ния.
•• MM SDK-комплект для разработки муль-

тимедийного программного обеспечения

(Multimedia Software Development Kit) [14],

который включает в себя примеры про-

грамм для реальных мультимедийных при-

ложений.

Разработка реального встраиваемого сете-

вого приложения может потребовать интег-

рации этих программных составных блоков

в единую систему. При интеграции разнород-

ных программных компонентов возможны

конфликты программных и аппаратных ре-

сурсов. Кроме того, использование програм-

мных компонентов со столь высоким уров-

нем абстракции на имеющей ограниченные

ресурсы встраиваемой платформе может при-

водить к неоптимальному использованию

системных ресурсов или к некорректному уп-

равлению ими.

Обзор LwIP

Стек LwIP представляет собой облегченную

реализацию стека протоколов TCP/IP. Это бес-

платное программное обеспечение с откры-

тым исходным кодом, которое можно загру-

зить по ссылке ht
tp://savannah.nongnu.o
rg/

cgi-bin/viewcvs/lwIP/lwIP/. Стек LwIP не тре-

бует большого объема памяти и поэтому хоро-

шо подходит для встраиваемых приложений.

Подробную информацию об LwIP можно най-

ти в Интернете по ссылке ht
tp://w
ww.sics.se/

~adam/lwIP/.

Стек LwIP портирован на процессоры

ADSP BF53x и ADSP BF56x и входит в состав

Компания Analog Devices портировала облегченный стек TCP/IP (LwIP,

light!weight TCP/IP) на семейство встраиваемых процессоров Blackfin.

Стек LwIP может использоваться в процессорах Blackfin для разработки

аудио/видеоприложений или приложений промышленной автоматиза!

ции с поддержкой сетевого взаимодействия. LwIP — это интересный про!

граммный пакет, который позволяет быстро преобразовывать автоном!

ное встраиваемое приложение в сетевое.

Создание сложных 

VDK/LwIP приложений 

на процессорах Blackfin

1 На процессоры Blackfin ADSP BF535 стек LwIP не портирован.

Рис. 1. Типичные встраиваемые сетевые приложения
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среды VisualDSP++. Можно начать разраба-

тывать TCP/IP приложения на процессорах

Blackfin с помощью оценочной системы

ADSP BF537 EZ KIT Lite, которая имеет встро-

енный интерфейс Ethernet. Для процессоров

ADSP BF533/BF532/BF531 и ADSP BF561 мо-

жет использоваться плата расширения USB

LAN. Информацию, необходимую для того,

чтобы начать разрабатывать проекты с под-

держкой TCP/IP, можно найти в LwIP User

Guide (руководство пользователя по LwIP) [1].

В реализации LwIP на процессорах Blackfin

используется ядро VisualDSP (VDK, VisualDSP

kernel) и библиотеки системных служб (SSL)

и драйверов устройств (DD). Информацию

о VDK и библиотеках системных служб мож-

но почерпнуть из публикаций [10] и [7].

Требования к ресурсам 
для работы LwIP 
на процессорах Blackfin

Пропускная способность LwIP 

на процессорах Blackfin

Пропускная способность портированного

на процессоры Blackfin стека LwIP измеря-

лась при помощи утилиты ADI TTCP [21],

построенной на основе бесплатной утилиты

PCATTCP.

На рис. 2 показана зависимость пиковой

пропускной способности от размера буфера

для реализации LwIP на платформе ADSP

BF537. Реальные результаты могут отличать-

ся от приведенных на рис. 2 и зависят от се-

тевого трафика и скорости, поддерживаемой

сетью. Как показано на рис. 2, поддерживае-

мая LwIP пропускная способность для стеков

протоколов TCP и UDP достигает 11 Мбайт/с.

Требования к памяти для LwIP 

на процессорах Blackfin

Как уже отмечалось ранее, в портирован-

ном на Blackfin стеке LwIP используется VDK

и библиотеки системных служб (SSL). В таб-

лице 1 указаны объемы памяти для каждого

из программных компонентов LwIP-прило-

жения в отдельности, что позволяет получить

лучшие оценки при интеграции проектов,

в которых уже используется один из этих

компонентов. Приведенные цифры являют-

ся приблизительными и соответствуют про-

стой программе Hello world, исполняемой

в стеке LwIP.

Другие необходимые системные ресурсы

Прерывания и DMA

При исполнении стека LwIP на процессо-

рах ADSP BF537 драйверы работают со встро-

енным контроллером Ethernet. По умолча-

нию прерывания каналов DMA Ethernet ото-

бражены в системное прерывание IVG11,

которое не используется другими каналами

DMA.

На процессорах ADSP BF533/BF532/BF531

и ADSP BF561 стек LwIP работает с платой

расширения USB LAN. По умолчанию драй-

вер устройства использует одно прерывание

для сигнализации как о приеме кадра, так

и о завершении передачи. В процессорах

ADSP BF533 для этих целей используется

прерывание IVG8, а в ADSP BF561 — IVG11.

Дополнительную информацию, касающую-

ся написания драйверов устройств, можно

найти в документации [3, 4].

Рекомендации к программному
и аппаратному обеспечению

Рекомендации к программному 

обеспечению

В реализации для процессоров Blackfin стек

LwIP исполняется на платформе VDK. Под-

разумевается, что пользователи LwIP знако-

мы с общими концепциями операционных

систем реального времени (ОСРВ) [13].

В этом разделе описываются распростра-

ненные конфликты программного обеспече-

ния, которые могут возникать при интегра-

ции LwIP с другими программными компо-

нентами или приложениями.
•• Любой программный компонент, который

использует библиотеки системных служб,

потребует, как минимум, применения пре-

рываний и менеджера DMA. При интегра-

ции двух и более проектов, использующих

библиотеки системных служб, необходи-

мо, чтобы в системе был только один ме-

неджер прерываний и только один менед-

жер DMA. Это также распространяется на

менеджеры устройств и отложенных об-

ратных вызовов, а также все прочие служ-

бы, используемые в системе.
•• Интеграция новых устройств или ресур-

сов в систему требует дополнительного вы-

деления памяти под менеджер прерываний

и менеджер драйверов устройств. Ниже

приводится листинг с макросом, исполь-

зуемым для назначения памяти устройст-

вам и каналам DMA. Вы можете подставить

свой множитель, исходя из количества ка-

налов и устройств в системе.

// Данные менеджера DMA (базовый адрес + память для 2 кана-

лов DMA)

static u8 DMAmgr_storage[ADI_DMA_BASE_MEMORY +

(ADI_DMA_CHANNEL_MEMORY * 2)];

// Данные менеджера устройств (базовый адрес + память для 2

устройств)

static u8 devmgr_storage[ADI_DEV_BASE_MEMORY +

(ADI_DEV_DEVICE_MEMORY * 2)];

Каждый программный компонент может

иметь свой собственный набор процедур

инициализации, который при интеграции

может конфликтовать с процедурами ини-

циализации других компонентов. Стандарт-

ные процедуры инициализации включают

в себя инициализацию прерываний, иници-

ализацию устройства, настройки сигнала так-

товой синхронизации и регулятора напря-

жения, инициализацию внешней памяти,

«кучи» и т. д. 

Рекомендации к аппаратным средствам

Зачастую работоспособная в автономном

режиме система может не работать в связке

с другими компонентами из-за ограничен-

ной пропускной способности платформы для

встраиваемых приложений. Процессоры

Blackfin имеют внутренние шины, разряд-

ность которых для разных представителей

различается (в процессорах ADSP BF53x раз-

рядность шин — 16 бит, а в ADSP BF561 —

32 бита). Каждая из внутренних шин процес-

сора может работать с максимальной часто-

той 133 МГц, и, следовательно, максималь-

ная скорость передачи данных составляет 266

или 532 Мбайт/с, в зависимости от разряднос-

ти шины. Существует ряд факторов, которые

Рис. 2. Зависимость пиковой пропускной способности

от размера буфера

Таблица 1. Распределение кода и данных в памяти для приложения на базе LwIP

Таблица 2. Требования к объему «кучи» для LwIP
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могут вызывать уменьшение доступной про-

пускной способности. К ним относятся задерж-

ки переключения системной шины с чтения

на запись, конфликты обращений к банкам па-

мяти, задержка из-за арбитража, конфликты

между ядром и контроллером DMA и т. д. Эти

факторы в различных приложениях проявля-

ются по-разному и зависят от динамического

взаимодействия процессов пересылки перифе-

рийных данных и обращений ядра. В разделе

«Оптимизация системы» обсуждаются мето-

ды оптимизации, позволяющие минимизи-

ровать влияние факторов, воздействующих

на пропускную способность системы, и, как

следствие, увеличить эффективность исполь-

зования системных ресурсов.

Управление прерываниями

Одно прерывание IVG может совместно ис-

пользоваться несколькими периферийными

узлами, и, кроме того, несколько програм-

мных компонентов могут использовать од-

но и то же прерывание IVG. При интеграции

в таблице векторов событий (EVT, event vec-

tor table) должна регистрироваться процеду-

ра обслуживания прерывания только для од-

ного из программных компонентов. Други-

ми словами, одному уровню приоритета IVG

может быть назначена только одна процеду-

ра обслуживания прерывания. Кроме того,

назначение периферийным узлам приорите-

тов и распределение их по разным уровням

приоритетов IVG заметно снижает сложность

системы.

Размещение кода и данных в памяти

При интеграции программных компонен-

тов любая оптимизация карты памяти (на-

пример, помещение кода, чувствительного

ко времени исполнения, а также кода и дан-

ных, к которым наиболее часто обращается

приложение, в память L1) потребует прове-

дения ее повторного анализа. Этот момент

зачастую игнорируют при использовании

программных компонентов от разных про-

изводителей, в которых применяется ручная

оптимизация карты памяти. При этом по-

ведение приложения (например, процент-

ное соотношение обращений к определен-

ным секциям кода и данных) после интег-

рации может измениться, что в конечном

итоге приведет к росту задержек обраще-

ния к памяти по сравнению с исполнением

программных компонентов по отдельности.

Поэтому после интеграции следует повтор-

но проанализировать размещение кода и дан-

ных в памяти.

Обработчики исключений 

и аппаратных ошибок

Для распределения времени между задача-

ми и управления другими действиями ядра

в VDK используется механизм исключений.

Обработчик исключения в VDK представля-

ет собой процедуру, интегрированную в код

ядра. Эта процедура передает все исключе-

ния, обусловленные ошибками, в пользова-

тельскую процедуру обработки исключений,

создаваемую по умолчанию. В приложениях,

в которых используются только библиотеки

системных служб, вам потребуется назначить

обработчик исключения вручную. Однако

при интеграции приложения, использующе-

го системные службы, в проект, работающий

под управлением VDK, выделять отдельный

обработчик исключения не следует. В этом

случае все исключения необходимо обраба-

тывать в пользовательской процедуре обслу-

живания, которая автоматически создается

в проекте с поддержкой VDK. Структура

пользовательской процедуры обслуживания

показана на рис. 3.

Прерывания ошибок

Большинство прерываний, вызванных сбо-

ями периферийных узлов, отображено в пре-

рывание IVG7. В связи с этим для эффектив-

ной отладки приложения важно локализовать

в явном виде источники ошибок DMA или

периферийных узлов. Использование в сис-

теме прерываний при сбоях — это лучший

способ обнаружения переполнения или не-

хватки данных в том или ином периферий-

ном узле. В качестве примера можно приве-

сти ситуацию, когда ресурс, имеющий высо-

кий приоритет, может не давать ресурсу

с более низким приоритетом обращаться

к памяти, в которой могут содержаться дан-

ные или даже дескриптор DMA.

Оптимизация системы

В этом разделе описывается несколько ме-

тодов программной и аппаратной оптимиза-

ции, которые помогут разработчикам в пол-

ной мере использовать все преимущества ар-

хитектуры процессоров Blackfin.

Аппаратная оптимизация

Существует целый ряд методов оптимиза-

ции системы. Ниже приводится рекоменду-

емый минимум:
•• 16/32-разрядные пересылки. При обмене

в режиме DMA с периферийными узлами

и в операциях DMA «память–память» все-

гда используйте максимальную разрядность

шины. В процессорах ADSP BF53x должны

инициироваться 16-разрядные, а в ADSP

BF561 — 32-разрядные пересылки.
•• Эффективное использование каналов DMA.

Не допускайте в одном канале DMA запу-

ска двух пересылок, которые пересекались

бы во времени.
•• Разбиение банков SDRAM. Для одновре-

менного обращения к нескольким буфе-

рам данных и минимизации времен пе-

реключения задайте для SDRAM конфи-

гурацию с 4 банками. Например, плата

ADSP BF561 EZ KIT Lite имеет 64 Мбайта

SDRAM, которые можно сконфигуриро-

вать как четыре банка по 16 Мбайт.

Для эффективного использования струк-

туры с разбиением на банки не разме-

щайте два буфера данных, обращение

к которым производится одновременно,

в одном банке SDRAM.
•• Управление трафиком DMA. Для эффек-

тивного расходования пропускной способ-

ности системы используйте регистры уп-

равления трафиком DMA. Эти регистры

позволяют влиять на частоту смены на-

правления передачи на шинах данных, ав-

томатически группируя передачи с совпа-

дающим направлением. Более подробную

информацию об оптимизации DMA мож-

но найти в руководствах [2, 3 или 4].
•• Сведите к минимуму конфликты между

ядром и контроллером DMA. Активиза-

ция кэша данных и команд может сущест-

венно увеличить производительность при-

ложения. Если программа имеет очень

большой размер (что характерно для при-

ложений LwIP/VDK), кэширование может

дать значительный прирост производи-

тельности.

Более подробная информация о методах оп-

тимизации содержится в литературе [4, 6 и 8].

/* Пользовательский обработчик исключений */

/* Точка входа пользовательского обработчика исключений */

.GLOBAL UserExceptionHandler;

UserExceptionHandler:

/**

* Обработка исключения...

*

* Следует помнить, что в VDK пользовательское исключение 0,  

* которое вызывается командой EXCPT 0;, зарезервировано

*

* 

*

* В этом обработчике вы должны обработать любые другие  

* исключения (пользовательские или системные).

*/

RTX;

.UserExceptionHandler.end:

Рис. 3. Процедура обслуживания исключений,

создаваемая по умолчанию в проекте 

с поддержкой VDK Рис. 4. Обработка данных в простой схеме с двойной буферизацией
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Программная оптимизация

Выполнение процедур 

обслуживания прерывания

Избегайте обработки данных в процедурах

обслуживания прерываний и обратных вы-

зовах. Буферы данных следует обрабатывать

в пользовательских потоках. Уровень при-

оритета прерываний выше, чем у определя-

емых пользователем потоков. Определяемые

пользователем потоки всегда выполняются

на уровне приоритета прерывания IVG15

(наименьший приоритет), а процедуры об-

служивания прерываний и обратные вызо-

вы [7] — на соответствующих им уровнях

приоритета. Для более эффективного исполь-

зования времени CPU понижайте приоритет

процедур обслуживания прерываний при по-

мощи отложенных обратных вызовов.

Низкоприоритетная процедура обслужи-

вания прерывания отложит обработку высо-

коприоритетной процедуры обслуживания

прерывания, если первая не поддерживает

вложение. В процессорах Blackfin реализован

механизм вложения прерываний, который

позволяет высокоприоритетным периферий-

ным узлам прерывать исполнение низкопри-

оритетных прерываний.

Эффективная схема 

управления буферами

Во избежание простоев процессора исполь-

зуйте схему двойной буферизации. Приме-

нение двойной или множественной буфери-

зации позволит процессору обрабатывать те-

кущий буфер во время заполнения других

буферов каналом DMA периферийного узла.

На рис. 4 показана простая схема управления

данными при двойной буферизации. Допол-

нительные примеры схем управления сдво-

енными или множественными буферами дан-

ных можно найти в книге [8].

Оптимизация при компиляции

Для повышения производительности при-

ложения может использоваться оптимизация

при компиляции. Наилучшие результаты до-

стигаются при использовании ключей ком-

пилятора -o и -ipa. Дополнительного улуч-

шения производительности можно добить-

ся применением оптимизации по результатам

профилирования (PGO, profile-guided opti-

mization). Подробное описание методов оп-

тимизации можно найти в главе руководст-

ва по компилятору [14] “Achieving Optimal

Performance from C/C++ Sources” (обеспече-

ние максимальной производительности ис-

ходного кода на C/C++). Для повышения про-

изводительности можно вручную оптимизи-

ровать некоторые процедуры обслуживания

прерываний и чувствительные ко времени

исполнения функции, реализовав их на язы-

ке ассемблера.

Оптимизация при компоновке

Внутренняя память процессора Blackfin

представляет собой SRAM первого уровня

(SRAM L1), которая зачастую используется

неэффективно. Помещение чувствительных

ко времени исполнения частей программы

и частей программы, к которым чаще дру-

гих происходит обращение, в SRAM L1 поз-

воляет избежать большинства потерь цик-

лов, возникающих вследствие промахов кэша.

Для локализации наиболее часто исполняе-

мых функций и их размещения в памяти

SRAM L1 используйте статистический про-

файлер (Tools -> Statistical profiler). Кроме то-

го, для обеспечения детерминированного вре-

мени реакции в SRAM L1 следует размещать

критические процедуры обслуживания пре-

рываний. Подробная информация о разме-

щении кода в памяти в процессорах Blackfin

дана в статье [9].

Общие рекомендации по отладке

В дополнение к стандартным возможнос-

тям, таким как программные точки останова

и окна вычисления выражений (Expressions)

или просмотра содержимого локальных пе-

ременных (Locals), средой VisualDSP++ сов-

местно с аппаратными средствами архитек-

туры Blackfin обеспечивается богатый набор

инструментов, позволяющих отлаживать

сложные системы. Рассмотрим некоторые из

ключевых инструментов отладки.

Окно истории VDK

Окно истории VDK (рис. 5) используется

для наблюдения за состоянием потоков, собы-

тиями, конфликтами потоков и т. д. Это окно

особенно полезно при отладке многопоточ-

ных приложений. Окно истории VDK вызы-

вается из основного меню VisualDSP++ IDDE

комбинацией View -> VDK windows -> History.

Окно состояния VDK

В окне состояния VDK (рис. 6) отображает-

ся состояние всех потоков, семафоров, сооб-

щений и других элементов системы. Окно со-

стояния VDK также отображает код ошибки

в ситуации «паники ядра» (Kernel Panic). Наи-

более распространенными ошибками, порож-

дающими панику ядра, является использова-

ние привилегированных (или запрещенных)

API-функций VDK в процедурах обслужива-

ния прерываний или обратных вызовах, а так-

же обращение к уже уничтоженным ресурсам

потока. Окно состояния VDK вызывается из

основного меню VisualDSP++ IDDE комбина-

цией View -> VDK windows -> Status.

Блок трассировки 

и регистры программного автомата

Для отладки исключения необходимо ло-

кализовать его причину, проанализировав со-

держимое поля EXCAUSE регистра SEQSTAT.

Адрес команды, которая вызвала исключе-

ние, сохраняется в регистре RETX. При воз-

никновении исключения запустите прило-

жение повторно, поместив при этом точку

останова на адрес команды, вызвавшей ис-

ключение, и активизировав буфер трасси-

ровки установкой двух битов в регистре

TBUFCTL. После этого можно выявить точ-

ную причину исключения, исследовав по-

следовательность команд, находящихся в бу-

фере трассировки.

Блок контрольных точек

При помощи регистров «контрольных то-

чек» (watchpoint) можно отлаживать ситу-

ации, когда ошибка возникает только при

n-ом обращении к команде или элементу

данных. Регистры контрольных точек поз-

воляют в таких случаях сгенерировать пре-

рывание эмуляции при (n–1)-ом обращении

к команде или элементу данных, после чего

можно перейти в режим пошагового испол-

нения для поиска причины исключения или

ошибки.

Регистры состояния 

периферийных узлов

При обнаружении ошибки периферийно-

го узла или канала DMA ее причина может

быть выявлена с помощью соответствующих

регистров состояния. Причиной ошибок мо-

гут быть как неправильная конфигурация,

так и неэффективное построение системы

(например, ошибки переполнения или не-

хватки данных в каналах DMA). Избавиться

от ошибок второго вида поможет более эф-

фективное управление буферами данных или

дальнейшее разбиение приложения на зада-

чи более низкого уровня.

При использовании библиотек систем-

ных служб (SSL) большинство причин оши-

бок может быть выявлено по кодам, возвра-

щаемым API функциями системных служб,

а также по кодам событий в функциях об-

ратных вызовов. Библиотеки SSL позволя-

ют идентифицировать ошибки в работе

периферийных узлов и DMA. В качестве

примера может использоваться любой из

Рис. 5. Окно истории VDK Рис. 6. Окно состояния VDK
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примеров, входящих в состав Multimedia

Starter Kit [14].

В этом разделе были кратко представлены

лишь некоторые из доступных методов от-

ладки. Дополнительную информацию мож-

но найти в публикации [17].

Заключение

Интеграция программных компонен-

тов — это сложная, нетривиальная задача.

При объединении нескольких програм-

мных компонентов возрастают требования

к пропускной способности, усложняется

анализ использования системных ресур-

сов, разрешение потенциальных про-

граммных и аппаратных конфликтов,

а также отладка приложения. Приведен-

ные в статье рекомендации позволят избе-

жать распространенных ошибок, возника-

ющих при интеграции программных ком-

понентов, и разработать оптимизированное

и устойчивое приложение.

Возможности, 
поддерживаемые LwIP

Список возможностей LwIP, поддержива-

ющихся на момент написания статьи, приве-

ден в ZIP-архиве, который находится на сай-

те Analog Devices [21]. Новые возможности,

добавленные в последующих версиях и об-

новлениях VisualDSP++, перечислены на

странице: ht
tp://w
ww.analog.c
om/processors/

blackfin/evaluationDevelopment/crosscore/

toolsUpgrades/index.ht
ml. ■
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